
 
 LAN9252-SAME54 EtherCAT Application Quick Start Guide

Introduction

This document describes how to use the EVB-LAN9252-PICtail™ Software Development Kit as a
development tool for the Microchip EVB LAN9252 EtherCAT® slave controller.

The following abbreviations are used in this Document:
• IDE - Integrated Development Environment
• ESC - EtherCAT Slave Controller
• EVB - Engineering Validation Board
• HAL - Hardware Abstraction Layer
• SPI - Serial Protocol Interface
• SSC - Slave Stack Code
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1. EtherCAT Pin Connection Guide Details

1.1 EtherCAT on SAME54

This document describes the hardware setup and I/O pin connections between the SAME54 Xplained Pro
evaluation kit (Part Number: ATSAME54-XPRO) and the EVB-LAN9252-PICtail add-on board (Part
Number: EVB-LAN9252-PICTAIL) through the Starter Kit I/O expansion board (Part Number: DM320002 )
required to run the EtherCAT solution on the SAME54 device.

This document provides a brief information about the development board, PICtail board, evaluation kits,
respective I/O pins, and connectors required for this evaluation setup.

For detailed information and schematics for each of the boards described above, refer to the respective
user guide’s and Information sheets which are available for download from the following location:

• SAME54 Xplained Pro Evaluation Kit User Guide: http://ww1.microchip.com/downloads/en/
DeviceDoc/70005321A.pdf

• EVB-LAN9252-PICtail Add-on Board User Guide: http://ww1.microchip.com/downloads/en/
DeviceDoc/50002427A.pdf

• Starter Kit I/O Expansion Board Information Sheet: http://ww1.microchip.com/downloads/en/
DeviceDoc/51950B.pdf

1.2 Hardware Setup
Soldering the required pins using smaller strands of wire is recommended, as shown in the following
figure. The use of fly wires will cause SPI high frequency signal integrity issues.
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Figure 1-1. SPI and Interrupt Pin HW Setup
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Table 1-1. SPI and Interrupt Board-to-Board Fly Wire Pin Connection

Functions SAME54 Port Pins
(Header-Pin)

Starter Kit I/O Expansion Board Pin
Connections

LAN9252 EVB Pic-Tail
Pin Connections

J10 Test Point
Headers J4 Edge Connector J1 Edge Connector

SPI SCK PB26 (EXT1-18) 41 3 3 (SCK)

SPI MOSI PB27 (EXT1-16) 43 7 7 (SDI)

SPI SS PB28 (EXT1-15) 46 1 1 (CS)

SPI MISO PB29 (EXT1-17) 44 5 5 (SDO)

SYNC1 PB16 (EXT2-14) 38 17 17 (SYNC1)

SYNC 0 PB15 (EXT2-8) 37 18 18 (SYNC 0)

ESC IRQ PB06 (EXT2-6) 36 49 49 (ESC IRQ)

Users need to ensure that both the boards are on common GND.
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1.3 SAME54 Xplained Pro Overview
The SAM E54 Xplained Pro evaluation kit is a hardware platform to evaluate the ATSAME54P20A.

The evaluation kit offers a set of features that enables the ATSAME54P20A users to get started with the
SAM E54 peripherals and to have an understanding of how to integrate the device in their design.

Figure 1-2. SAM E54 Xplained Pro Evaluation Kit

1.4 EVB-LAN9252-PICtail Add-On Board
The EVB-LAN9252-PICtail add-on board is used for evaluating Microchip’s LAN9252, a 2/3-port
EtherCAT slave controller with dual integrated Ethernet PHYs.

Features

• The EVB-LAN9252-PICtail add-on board supports the option to select HBI PDI and SPI/SQI
configurations
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• An onboard EEPROM to configure the EtherCAT slave configuration
• The EVB-LAN9252-PICtail add-on board supports two Integrated PHY's through on board RJ45

Connectors

Figure 1-3. EVB-LAN9252-PICTAIL ADD-ON BOARD
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Figure 1-4. EVB-LAN9252-PICtail™ Add-On Board Edge Connector J1

1.5 Starter Kit I/O Expansion Board
The Starter Kit I/O expansion board provides the starter kit and starter board users with full access to
MCU signals, additional debug headers, and connection of PICtail Plus daughter cards. The MCU signals
are available for attaching prototype circuits, or monitoring signals with logic probes.
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Figure 1-5. Starter Kit I/O Expansion Board

Figure 1-6. Starter Kit I/O Expansion Board J4 Connector
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Figure 1-7. Starter Kit I/O Expansion Board J10 Connector

1.6 LAN9252 PICTAIL PLUS and I/O expansion INTERFACE
Plug in the EVB-LAN9252-PICtail add-on board J1 edge connector to the topmost position of the J4 slot
on the Starter Kit I/O expansion board, as shown in the following figure.
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Figure 1-8. LAN9252 PICTAIL-I/O Expansion Interface
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2. EVB LAN9252-PICtail Add On Board (SPI Mode)

2.1 EtherCAT Master and Slave Configuration
The following steps describe how to configure the EtherCAT master and slave.

1. Configure the master with the TwinCAT driver.
Note:  Refer to Appendix A for information on Windows® configuration.

2. Unzip and extract the LAN9252-SAME54-SDK-Vx.x.zip file.
Note:  Vx.x denotes the version number of the SDK.

3. In SDK, \ESI Files directory contains the ESI file, which can be loaded to the EVB LAN9252-PICtail
EEPROM using the TwinCAT utility, SAME54 EtherCAT slave.xml.
Note:  Refer toAppendix D to change the vendor ID and the slave information in the ESI files.

4. Copy the Microchip_LAN9252_ SSC_Config.xml file to the directory path: C:\TwinCAT
\3.1\Config\Io\EtherCAT for TwinCAT 3.1.

5. Configure the evaluation board in SPI mode. Refer to the EVB-LAN9252-PICtail Add-on Board
User’s Guide for additional information on configuration: http://ww1.microchip.com/downloads/en/
DeviceDoc/50002427A.pdf.

6. To program the default ESI file of the SAME54 firmware for the SAME54 controller, refer to 
Appendix D and Appendix E.
Note:  The pre-built binaries are available in the Binaries directory.

7. Launch TwinCAT and then scan the EtherCAT slaves from TwinCAT. Refer to Appendix C for
information on how to scan the slaves.

8. Program the EEPROM using the SAME54 EtherCAT Slave.xml file. Refer to Appendix B before
programming the EEPROM. If the EEPROM is programmed successfully, the device state will enter
into OP mode as shown below.
Figure 2-1. Device OP Mode

9. Once the EEPROM is programmed successfully, the state of the device will change to OP mode.
Note:  If the device changes to OP mode, then the device is in an operational state. If the device is
not in OP mode, then there is an issue with the setup.

 
EVB LAN9252-PICtail Add On Board (SPI Mode)

© 2018 Microchip Technology Inc.  DS70005377A-page 11

http://ww1.microchip.com/downloads/en/DeviceDoc/50002427A.pdf
http://ww1.microchip.com/downloads/en/DeviceDoc/50002427A.pdf


2.2 Demonstration
This section describes the demonstration of the EVB-LAN9252-PICtail in SPI mode.

1. Follow the steps as provided in EtherCat Master and Slave Configuration. There is one input and
one output. The object variable can be seen in the solution explorer of the TwinCAT tool as shown
in the following figure.
Figure 2-2. EtherCAT Slave Variable Addition

As part of this demonstration, two object variables are available and are described in the following
table.

Table 2-1. Output Process Variable

Counter Value of Counter is determined based on Trigger value. If the Trigger value is 0, then the
Counter is cleared.

Trigger Trigger value is used to determine the value of the Counter.

2. To change the Trigger value, click on the Trigger which is available under ‘Output process data
mapping’ in the Search Solution Explorer window as shown below. The TwinCAT project window
will be displayed.
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Figure 2-3. Twincat Project Window

3. Change the Trigger value to a five or zero as shown in the following figure (The Trigger value can
be anything. The Trigger value used here is only an example).
Figure 2-4. Initial Trigger Variable
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Figure 2-5. Configure Trigger Variable

4. The Counter value will be incremented based on the Trigger value as shown in the following figure.
(The Counter value will not be a stable value, and will keep the increment based on the Trigger
value. The following figure is shown as an example).

Figure 2-6. Counter Output
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3. Appendix A

Setting up Master in Windows
To setup master in Windows, follow these steps:

1. Download and install TwinCAT 3.1 on Windows from the following location: http://beckhoff.com/.
2. TwinCAT Ethernet driver installation:

– If the TwinCAT tool is installed successfully, a TwinCAT icon will be shown in bottom-right
corner of the desktop. After clicking the icon, a pop-up window will be displayed. Select
TwinCAT XAE (VS XXXX) as shown in the following figure.

Note:  VS XXXX refers to version of the Visual Studio installed on the computer.

Figure 3-1. TwinCAT Manager

3. On the TwinCAT Project1 window, from TWINCAT > Show RealTime Ethernet Compatible Devices.
Figure 3-2. Show Real Time Ethernet Compatible Devices

4. Select the Network adapter, and then install the TwinCAT driver.
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Figure 3-3. Select Network Adapter

5. Once the TwinCAT driver is installed successfully, the driver is compatible with the TwinCAT master.
Now the network adapter is moved under Installed and ready to use devices as shown in the
following figure.
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Figure 3-4. TwinCAT Ethernet Adapter Installed And Ready To Use

6. Go to the corresponding network adapter properties by clicking View network status and tasks and
Change adapter settings in the Control Panel.
Figure 3-5. Configure Network Adapter Properties
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Figure 3-6. Ethernet Adapter Setting

7. Select the TwinCAT drivers as shown in the following figures. Right-click on Local Area Connection
and then select Properties from the short-cut menu. The Local Area Connection properties window
will be displayed, see below image.
Figure 3-7. Network Adapter Properties Menu

 
Appendix A

© 2018 Microchip Technology Inc.  DS70005377A-page 18



Figure 3-8. Local Area Connection Properties

8. Select TwinCAT Ethernet Protocol, and then click OK.
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4. Appendix B

EEPROM Programming
To program the EEPROM, follow these steps:

1. After a successful scan, click on Device 2 (EtherCAT) in the solution explorer window of the
TwinCAT tool as shown in the following figure.
Figure 4-1. TwinCAT Scans EtherCAT Device2

2. Click Online in the TwinCAT project window.
3. Right-click on the LAN9252 listings, and then select EEPROM Update from the contextual menu.

Figure 4-2. Select LAN9252 Setting for EEPROM Update

4. Upon selecting EEPROM Update, the Write EEPROM window will be displayed. Choose the
corresponding EEPROM configuration, and then Click OK to initiate the EEPROM programming.
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Figure 4-3. Write EEPROM Dialog

5. The above figure shows an example of the LAN9252 SPI configuration selected for EEPROM
programming in the TwinCAT.
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5. Appendix C

Scanning EtherCAT Slaves
To scan EtherCAT Slaves, perform these actions:

1. Connect Port zero of the device to the master using a RJ45 Ethernet cable, and then power up the
board. The Link/Act LED should be ON at Port zero when the cable is present. If the Link/Act LED
is not ON, it indicates there is an issue with the connection or cable.

2. If any devices are present, delete them by right-clicking the device and select Remove as shown in
the following figure. If there are no devices in the solution explorer, then skip this step.
Figure 5-1. Remove Previous Scanned EtherCAT Slave Devices

3. If master is in RUN mode, then it will not detect the slave as described in the steps five and six.

Ensure that the master is in Config mode, by clicking Restart TwinCAT.
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Figure 5-2. Restart TwinCAT

4. Scan for EtherCAT slave devices by right clicking Devices and then select Scan as shown in the
following figure.
Figure 5-3. Scan EtherCAT Slaves

5. Click OK to continue scanning as shown in the below image.
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Figure 5-4. Device Dialog

6. If the check box is not selected as shown in the following figure then either the device is not
functional, or the driver is not installed properly.
Figure 5-5. Device Dialog, Unchecked

7. Click Yes to choose to scan for boxes.
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Figure 5-6. Confirmation Dialog

Figure 5-7. Select Scanned EtherCAT Device2 (Device List)

8. After a successful scan, there will be activity on Link/Act LED at Port zero.
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6. Appendix D

Generating EtherCAT Slave Stack Code (SSC) files
To generate the SSC files, follow these steps:

1. Select the SSC tool (Version 5.11) from the Start menu, as shown in the following figure.
Figure 6-1. SSC Tool Installation Steps

2. From the File menu select New to continue.
Figure 6-2. New EtherCAT Slave

3. Click Import to import the SSC Tool configuration file, Microchip-SAME54-EtherCAT-
Slave_SSC_Config.xml, from the directory {SDK_INSTALL_PATH}/ LAN9252-SAME54-SDK-
Vx.x/.
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Figure 6-3. Import Project

4. After selecting the file, click Open to import the SSC Tool configuration file.
5. Once imported, from the Custom drop-down menu, select the Microchip_LAN9252_SSC_Config,

and then click OK.
Figure 6-4. Custom SSC File Selected

6. After selecting the configuration, the SSC will prompt for the 9252_HW.c file. Click OK and choose
the 9252_HW.c file from this path: {SDK_INSTALL_PATH}/ LAN9252-SAME54-SDK-Vx.x / SSC /
Common.
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Figure 6-5. Slave Stack Code Tool Dialog

Figure 6-6. Select 9252_hw.c File

7. All listed parameters under Slave Information can be changed as shown in the following figure.
Note:  By default, SDK ESI files have an object configuration with a Microchip vendor ID.
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Figure 6-7. Slave Information Setting

8. Tool >Application > Import.
Figure 6-8. Import EtherCAT Slave Application Code

9. Select the sample_app.xlsx file, which is available in the directory {SDK_INSTALL_PATH}/
LAN9252-SAME54-SDK-Vx.x / Sample application.
The sample_app.xlsx object file contains the information about application objects.
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10. Once the file is selected, status message will be displayed as shown in the following figure. Click
OK to continue.
Figure 6-9. Status Message

11. Click the Project drop-down menu in the tool bar, and then select Create New Slave Files. The
following figure shows the pop up window.
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Figure 6-10. Create New Slave Files

Note: 
$PROJECT_FILE_PATH – The location where the SSC project file is saved.

$SRC_FILE_PATH – Default path is $PROJECT_FILE_PATH. It can be changed by clicking the
Change button in the pop up.

$ESI_FILE_PATH – Default path is $PROJECT_FILE_PATH. It can be changed by clicking the
Change button in the pop up.

12. Click Start to create a new project file, the SRC folder, and the ESI file (Slave Information file) in
the desired directory path.

13. A pop-up window indicates that the files are successfully created. Click OK to continue.
14. Along with generated new slave files, the ESI file (.xml file) also will be generated. This ESI file will

have information about the new vendor ID and object configuration. Program this ESI file into the
EEPROM as mentioned in Appendix B.

15. Replace the generated application files in the SRC folder with the SDK application files as shown in
the following figure.

– The SDK Application files can be found in Sample application.
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Figure 6-11. SDK Application Files

16. Application files are named as sample_app.
In this demonstration, the input object file is named as sample_app.xlsx.

Figure 6-12. Copy The Generated Application Files

17. Browse to the directory where new files are created:
– SRC (Folder): Contains the Beckhoff Slave Stack code.
– SAME54 EtherCAT Slave (ESP): The SSC Tool project file.
– SAME54 EtherCAT Slave (XML): The EtherCAT slave information file, must be used as an

input to the EtherCAT master tool to configure the EtherCAT slave controllers.
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18. Copy above mentioned files into the SRC folder under the directory: {SDK_INSTALL_PATH}/
LAN9252-SAME54-SDK-VX.X /SSC/Common.

Note:  The file replacement is required for these reasons:
• The default sample_app.c file does not have the counter and trigger configuration details, hence

the user can add the modifying code for the counter and trigger.
• The generated application files will not have the code for modifying the Output Counter. Modifying

the Output Counter based on the Input trigger value in the sample application provided, is delivered
in the SDK application files. It is required to run the demonstration application.
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7. Appendix E

Compiling and Programming SOC Firmware
To compile and program the SOC firmware, follow these steps:

1. Open Atmel Studio 7. From File > Open > Project/Solution and then import the SSC project into the
IDE. The Atmel Studio Project file is located under {SDK_INSTALL_PATH}/ LAN9252-SAME54-
SDK-VX.X/SSC/SAM.
Figure 7-1. Open Project in Atmel Studio

2. Browse to the project location and then open the Atmel Studio solution file
etherCATSamE54.cproj.
Figure 7-2. EtherCAT Project Path

3. Project will be loaded as shown in the following figure.
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Figure 7-3. EtherCAT Project with E54

4. The SSC generated files are not added into the SDK distribution. Therefore, as the project is
loaded into the IDE, the following files are not located by the IDE.
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Figure 7-4. EtherCAT Library SSC Generated Files

Ensure that required files are generated and added to the appropriate location
{SDK_INSTALL_PATH}/ LAN9252-SPI_SAME54_SDK_V1.0_aplha/etherCATSamE54/SSC/
Common.

Refer to Appendix D on how to generate the EtherCAT Slave Stack files using the SSC tool.

The application files are required to be generated and added to the appropriate location. Refer to 
Appendix D.

5. Compile the source code as shown in the following figure.
Figure 7-5. Compile the EtherCAT Project

6. Once the source code is compiled successfully, the output window will display a build successful
message as shown in the following figure.

 
Appendix E

© 2018 Microchip Technology Inc.  DS70005377A-page 36



Figure 7-6. Project Build Result

7. Before initiating the firmware download, ensure that the debugger, programmer, and Xplained Pro
board are connected to the device which is running Atmel Studio.

8. To debug the SAME54 host, click Debug Main Project.
Figure 7-7. Debug Main Project

 
Appendix E

© 2018 Microchip Technology Inc.  DS70005377A-page 37



8. Appendix F

Programming the SAME54 Firmware Using Pre-Built Binaries
1. Download and install Atmel Studio v7.0 from the following location: https://www.microchip.com/avr-

support/atmel-studio-7.
2. Before initiating the firmware download, ensure that the debugger, programmer, and Xplained Pro

board is connected to the device running Atmel Studio 7.
3. Open Atmel Studio and from Tools > Device Programming.

Figure 8-1. Select Device Program Option

4. In the Device Programming window, under Tools, select the options as shown in the following
figure.
Figure 8-2. Select Device to Program

5. Select the options under Device as shown in the following figure.
Figure 8-3. Select Atmel Device

6. Click Apply.
Figure 8-4. Apply Programming

7. Click Memories and then browse to the .hex file location.
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Figure 8-5. Erase Flash Memory

8. Once the .hex files are loaded, click Program to program the SAME54 firmware.
Figure 8-6. Select EtherCAT Binary File
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9. Appendix: Revision History
November 2018

This is the initial released version of this document.
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The Microchip Web Site

Microchip provides online support via our web site at http://www.microchip.com/. This web site is used as
a means to make files and information easily available to customers. Accessible by using your favorite
Internet browser, the web site contains the following information:

• Product Support – Data sheets and errata, application notes and sample programs, design
resources, user’s guides and hardware support documents, latest software releases and archived
software

• General Technical Support – Frequently Asked Questions (FAQ), technical support requests,
online discussion groups, Microchip consultant program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases,
listing of seminars and events, listings of Microchip sales offices, distributors and factory
representatives

Customer Change Notification Service

Microchip’s customer notification service helps keep customers current on Microchip products.
Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata
related to a specified product family or development tool of interest.

To register, access the Microchip web site at http://www.microchip.com/. Under “Support”, click on
“Customer Change Notification” and follow the registration instructions.

Customer Support

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support

Customers should contact their distributor, representative or Field Application Engineer (FAE) for support.
Local sales offices are also available to help customers. A listing of sales offices and locations is included
in the back of this document.

Technical support is available through the web site at: http://www.microchip.com/support

Microchip Devices Code Protection Feature

Note the following details of the code protection feature on Microchip devices:

• Microchip products meet the specification contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is one of the most secure families of its kind on the

market today, when used in the intended manner and under normal conditions.
• There are dishonest and possibly illegal methods used to breach the code protection feature. All of

these methods, to our knowledge, require using the Microchip products in a manner outside the
operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is
engaged in theft of intellectual property.

• Microchip is willing to work with the customer who is concerned about the integrity of their code.
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• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their
code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the
code protection features of our products. Attempts to break Microchip’s code protection feature may be a
violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software
or other copyrighted work, you may have a right to sue for relief under that Act.

Legal Notice

Information contained in this publication regarding device applications and the like is provided only for
your convenience and may be superseded by updates. It is your responsibility to ensure that your
application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS
CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE.
Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life
support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend,
indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting
from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual
property rights unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, AnyRate, AVR, AVR logo, AVR Freaks, BitCloud,
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